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1) Complete the following sentences from the brackets:
(Network – Internet Explorer – Modem – Internet - Email)
1. ………………………….. Means connecting computers to each other's for sharing
the information and providing some services, and they may be in the same
room, building or in separated places .
2. ………………………….. is a device used for connecting the computer to the
telephone line.
3. ………………………….. Is used for displaying the Internet pages and sites.
4. We can get information with the least cost via …………………………...
5. We can send and receive emails in a short time using …………………………...
2) Complete the following sentences from the brackets:
(Identity theft – Password – Virus – Hacker – Wasting Time)
1. ………………………….. is undesired program and it has destructive functions
and is able to reproduce itself.
2. Stealing the personal data as the passwords and banks accounts details is
called …………………………...
3. The person who makes the non-permitted penetration of the computer is
called …………………………...
4. From the precautions for using the computer, is to protect the computer via
…………………………...

5. From the negative effects of using the Internet is …………………………...
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3) Complete the following sentences from the brackets:
(HTML - Address Bar – Information Pages – Hyperlink – Internet Explorer)
1. The site consists of one or group of connected …………………………...
2. …………………………..is of the most famous browsing programs.
3. Internet Explorer is used in opening the …………………………..files.
4. The desired site address is typed in …………………………...
5. …………………………..is a text or image in the information page and when click on
it, another site will be opened.
4) Complete the following sentences from the brackets:
(Notepad – Source – HTML – Tag – Internet)
1. HTML files should be with the extension of…………………………...
2. Using HTML doesn't need connection to …………………………...
3. We can view the programming code of any web page through
…………………………..From View menu.

4. …………………………..Is an editor which is used for typing the HTML commands.
5. ………………………….. is the statement between the brackets <>.
5) Put (√) or (X):
1. Internet Network is one of the most important sources of the information. (

)

2. We should use a browser for opening the Internet pages.

(

)

3. The site www.google.com is from the most important sites for creating free
emails.
(

)

4. The connected computers for creating a network should be in the same place.
(
)
5. The ease of dealing and connection are of the advantages of the Internet network.
(
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)

6) Put (√) or (X):
1. We can browse the Internet Sites and pages without using any browser. (

)

2. There is one way for opening Internet Explorer through its icon on the Desktop.

3. Hyperlink may be in the form of text or image in the information page.

(

)

(

)

4. We can load the site after typing its address through clicking Go on the Address
Bar.
5. The first site page which appears is named the default.

(

)

(

)

(

)

(

)

7) Put (  ) or ( ) :
1. HTML isn’t a programming language similar to the other programming
languages.
2. When using HTML the computer should be connected to the Internet.

3. The browser never affected by the spaces or lines between the statements. (

)

4. The statements are typed between brackets ( ) in HTML.

(

)

5. All the files typed in HTML code should begin with the tag <HTML>.

(

)
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8) Match from (A) to the suitable in (B):
A

B

1. E mail

(

)

A. To get information in any field and in
anytime.

2. Chat

(

)

B. For providing the selling and buying
information via Internet

3. Search

(

)

C. For making conversation among many
persons on the Internet.

4. E-commerce

(1,

)

(2,

(

)

)

(3,

D. For sending and receiving emails.

)

(4,

)

9) Put (√) or (X):
1. There may be many sites with the same addresses.

(

)

2. Virus is unwanted program which leads at destructing the computers files and
programs.

(

)

3. Using the Internet for long periods leads at being addicted to the Internet and
wasting time.

(

)

4. Viruses aren't able to reproduce themselves.

(

)

5. We should type the site address accurately.

(

)

Final - Second Term
5

10) Choose the correct answer from the brackets:
1. After opening Internet Explorer, the website address is written in the ………………..
bar.

(Address – Menu – Website Address)

2. To load the site, click Go or press ……………….. Button from the keyboard.
( Shift – Enter – Ctrl )
3. To print a page containing important information from any site, click Print from
……………….. Menu

(Edit – File – View )

4. We can chat with any person all over the world at the same time via Internet
through ………………...

(Email – Search – Chat )

5. ……………….. From the requirement for connection to the Internet.
(Paint – Telephone line – T.V)
11) Choose the correct answer from the brackets:
1. One or group of related web pages is called ………..…….
(Site main page – website – web page)
2. A link which transfers you to another site is (Site address – email – hyperlink)
3. After typing the site address in Internet Explorer, press ………..……. Button from
the keyboard to load the site.

(Alt – Shift– Enter)

4. ………..……. click on Internet Explorer icon to open this site window.
(One – double – three)
5. The site address is typed in ………..……. in the browser window.
(Address Bar – Title Bar – Tools Bar)
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12) Give the suitable term for the following sentences:
1. The tag which contains the title of the web page which appears in the browser's
Title Bar.

(…………………………………)

2. Means all what is typed between the brackets < >.

(…………………………………)

3. A simple and easy language which is used for creating and designing the
information page on the Internet.

(…………………………………)

13) Correct the underline in the following sentences:
1. You can view the code of any information page by opening File menu and
selecting Source in the browser.

(……………..……..)

2. The difference between the start and end statements is -.

(……………..……..)

3. To save the statements in Notepad, select Open from File menu.
(……………..……..)
4. WordPad is one of the Internet browsers.

(……………..……..)

5. All HTML files should ends with the statement <HTML>.

(……………..……..)

6. All the contents of the web page are typed in the code between the start and the
end of the tags <HTML>.

(……………..……..)

14) Complete the following:
From the advantages of the Internet Network:
1. ………………………………………………………………….
2. ………………………………………………………………….
3. ………………………………………………………………….
4. ………………………………………………………………….
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15) Put (√) or (X) :1. BgColor property is being shared by many Tags.

(

)

2. To view the designed files by HTML, use the paint program. (

)

3. We can’t change style of the default font of the browser.

(

)

4. To change the font style, we use the property Face.

(

)

5. Align is used for changing the text location in the web page. (

)

16) Choose the correct answer from the brackets:
1. BgColor is used with Tag

(<P> - <Body> - <Title>).

2. To save changes, select

(Save As – Open – Save).

3. From the properties of < P> Tag is

(Align – BgColor – Background).

4. To refresh the web page and view the changes, press …….. Button on the
keyboard.

(F2 – F5 – F3 )

5. We should type the text which needs to be processed ……..End Tag.
(Before – With – After )
6. To change the font size to bigger font:
a. <Font size = (7)>
b.<Font size ="7">
c. <Font size = 7 >
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17) Put (√) or (X):1. When using the Tag <BR>, it should be ended with the Tag </BR>.

(

)

2. The property Dir is used with the Tag <Body>.

(

)

3. Center tag is used for aligning the text to the middle of the web page.

(

)

4. To create a numbering list, we use the tag <OL> and </OL>to determine the end
and start of the list.

(

)

5. The single tag <LI> is used for creating the items in the sequential list only.
(
18) Match from (A) to the suitable in (B):A

B

1

<Center>

A

It is a single tag which is typed at the end of the line
for creating a new line or paragraph.

2

<P>

B

A property which is used for controlling the shape
of symbols in the lists

3

<BR>

C

A tag for aligning the text at the middle of the page
in general

4

<DIR>

D

A tag which is used in alignment by using the Align
property

5

Type

E

A tag for adding an item in the list

6

<LI>

F

A property which is used to control the text
direction in the page

(1,

)

(2,

)

(3,

)

(4,

)
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(5,

)

(6,

)

)

19) Give the suitable term for the following sentences:
(Start button – program – loading a program)
1. Copying a program from the hard disk to memory and the program display on the
screen.

(……………………………..)

2. A button on the desktop, when clicking it, a menu opens and is used for opening
programs. (……………………………..)
3. One or more files saved on the memory, when double click on it, a copy of it will
be on the memory and will appear on the screen. (……………………………..)
20) Match from (A) to the suitable in (B):
A

B

1

Status Bar

A

An empty white space for typing in it.

2

Title Bar

B

A set of menus containing commands.

3

Scroll bars

C

4

Text Cursor

D

5

Tool Bar

E

6

Menu Bar

F

7

(1,

Space of writing

)

(2,

)

G

(3,

It appears in the typing space and takes the shape
of I
It contains the program and file names.
It is down to the program window and it displays
information about the page.
It displays the hidden location in the page.
It contains icons for the important commands in
the menus.

)

(4,

)
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(5,

)

(6,

)

(7,

)

21) Complete the following sentences from between brackets:
(Format – Format Bar – Edit – Selection – Open - File)
1. ………………………. means selecting a part or all of the text to format it.
2. ………………………. means the style of text as the text size and color.
3. To open a text file on the computer, select ………………………. from File menu.
4. We can format the text by ………………………..
5. To create a new Document, select "New" from ………………………. Menu.
22) Match from (A) to the suitable in (B):
(A)

(B)

1

A

To make the font italic.

2

B

To underlline the text.

3

C

To make the font bold.

(1,

)

(2,

)

(3,

)
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23) Put (√) or (×):
1. When making changes to a previously saved file, there will be no difference
between Save and Save As.

(

)

2. There is automatically an icon for Save As in the Toolbar.

(

)

3. We can't connect many printers to the computer.

(

)

4. Print and Print Preview have icons in the Toolbar.

(

)

5. We find Save and Print command in Edit menu.

(

)

24) Complete the following sentences from the brackets:

(File – paper – Print Preview – Close – Save As – Save in )
1. To select Save As, open ……………………... Menu.
2. When applying changes to a previously saved file and we want to change it name
or location, select ……………………....
3. Select save location from the menu beside ……………………....
4. We use ……………………... to make a preview of the page before printing it.
5. To close Print Preview window, click ……………………....
6. The printer is a device which is used to get the document in the form of
……………………....
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Model One
A. Put (√) or (×):
1) Internet network means the connection of computers in the same location.
(

)

2) Hyperlink may be in the form of an image in the web page. (

)

3) Paint program is used to deal with the texts.

(

)

4) The site may be one web page or more connected together. (

)

5) The virus is a program which has destructive and unwanted functions.
(

)

B. Complete the following sentences from the brackets:
(WordPad – Modem – HTML – Identity theft – Start)
1) …………………….. is a language which is used to design the internet pages and
sites.
2) …………………….. is used to deal with texts.
3) We can open any program on the computer by …………………….. menu.
4) …………………….. Is of the harmful consequences from using the internet.
5) …………………….. Is a device which connects computers by the telephone line.
C. Arrange the following steps for opening WordPad program:
1) Select Accessories.

(

)

2) Open Start menu by clicking Start from the Task Bar.

(

)

3) Select WordPad from the menu that will appear.

(

)

4) Click on All Programs.

(

)
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Model Two
A. Correct the underline in the following sentences:
1) Color property is from the properties of <Body> in HTML.

(…………………)

2) E-mail is used in making conversations among many persons on the internet.
(…………………)
3) In HTML the tag < Title > is what all the page contents are typed in it.
4) Save As is used to save changes to the document in WordPad program with
the same name.

(…………………)

5) Saving HTML should be with the extension txt.

(…………………)

B. Complete the following sentences from the brackets:
1) ……………. Menu is used to format the text in Notepad.
(View – Format – Edit)
2) The tag ……………. Is used in typing the text in the middle of the page.
(< Center > - < Title > - < Body >)
3) ……………. Means a text or image in the web page to move to another page or
site.
(Hyperlink – Website – URL)
4) After typing the site address in the browser, click ……………. To load the site.
( OK – Yes – Go )
5) ……………. Bar is used to view the hidden part of the paper in the Notepad.
(Menu – Scroll – Status)
C. Complete to design a web page in which the word “Egypt” appears in
the Center of the page and the Title is New :
<HTML>
<Head>
<…….….>
New
</…….….>
</…….….>
<Body>
<…….….>
Egypt
</…….….>
</Body>
</…….….>
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Model Three
A. Put (√) or (×):
1) Save is used in WordPad to save changes.
(
)
2) There is no difference between the tags <P> and < BR > when creating a new
line.
(
)
3) The tag < L > is used for adding an item to the sequential list.
(
)
4) From the ways of using the internet safely, is to upgrade all the programs
including the operating system copy.
(
)
5) To activate the page in the browser, press F2 on the keyboard.
(
)
B. Complete the following:
1) From the advantages of HTML:
a)…………………..………….
b) …………………..………….
2) The steps for printing two copies from the current page in the WordPad
program:
a) …………………..………….
b) …………………..………….
c) …………………..………….
C. Complete to design web page with a yellow background containing a
headline ( The Egypt universities ) in the center of the page in red color
with font size 6 and contains a sequential list of the names of four
universities:
<HTML>
<Body BgColor = "…………….">
<P Align = "…….….….">
<Font Color = "…….…." Size = "6">
The Egypt universities
</…….….>
</…….….>
<OL>
<…….….>Cairo university
<…….….>Ein Shams University
<…….….>Alexandria University
<…….….>Tanta University
</…….….>
</…….….>
</HTML>
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Answers
1) Complete the following sentences from the brackets:
(Network – Internet Explorer – Modem – Internet - Email)
1. Network means connecting computers to each other's for sharing the
information and providing some services and they may be in the same
room, building or in separated places.
2. Modem is a device used for connecting the computer to the telephone line.
3. Internet Explorer is used for displaying the Internet pages and sites.
4. We can get information with the least cost via Internet.
5. We can send and receive emails in a short time using Email.
2) Complete the following sentences from the brackets:
(Identity theft – Password – Virus – Hacker – Wasting Time)
1. Virus is undesired program and it has destructive functions and is able to
reproduce itself.
2. Stealing the personal data as the passwords and banks accounts details is
called Identity theft.
3. The person who makes the non-permitted penetration of the computer is
called Hacker.
4. From the precautions for using the computer, is to protect the computer via
Password.
5. From the negative effects of using the Internet is Wasting Time.
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3) Complete the following sentences from the brackets:
(HTML - Address Bar – Information Pages – Hyperlink – Internet Explorer)
1. The site consists of one or group of connected Information Pages.
2. Internet Explorer is of the most famous browsing programs.
3. Internet Explorer is used in opening the HTML files.
4. The desired site address is typed in Address Bar.
5. Hyperlink is a text or image in the information page and when click on it, another
site will be opened.
4) Complete the following sentences from the brackets:
(Notepad – Source – HTML – Tag – Internet)
6. HTML files should be with the extension of HTML.
7. Using HTML doesn't need connection to Internet.
8. We can view the programming code of any web page through Source From
View menu.
9. Notepad is an editor which is used for typing the HTML commands.
10.

Tag is the statement between the brackets <>.

5) Put (√) or (X):
1. Internet Network is one of the most important sources of the information. (√)
2. We should use a browser for opening the Internet pages.

(√)

3. The site www.google.com is from the most important sites for creating free
emails.
(×)
4. The connected computers for creating a network should be in the same place.
(×)
5. The ease of dealing and connection are of the advantages of the Internet Network.
(√)
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6) Put (√) or (X):
1. We can browse the Internet Sites and pages without using any browser. (×)
2. There is one way for opening Internet Explorer through its icon on the Desktop.
(×)
3. Hyperlink may be in the form of text or image in the information page.

(√)

4. We can load the site after typing its address through clicking Go on the Address
Bar.

(√)

5. The first site page which appears is named the default.

(×)

7) Put (  ) or ( ) :
1. HTML isn’t a programming language similar to the other programming
languages.

(√)

2. When using HTML the computer should be connected to the Internet.

(×)

3. The browser never affected by the spaces or lines between the statements.
(√)
4. The statements are typed between brackets ( ) in HTML.

(×)

5. All the files typed in HTML code should begin with the tag <HTML>.

(√)
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8) Match from (A) to the suitable in (B):
A

B

1. E mail

A. To get information in any field and in
anytime.

2. Chat

B. For providing the selling and buying
information via Internet

3. Search

C. For making conversation among many
persons on the Internet.

4. E-commerce

D. For sending and receiving emails.

(1, D)

(2, C)

(3, A)

(4, B)

9) Put (√) or (X):
1. There may be many sites with the same addresses.

(×)

2. Virus is unwanted program which leads at destructing the computers files and
programs.

(√)

3. Using the Internet for long periods leads at being addicted to the Internet and
wasting time.

(√)

4. Viruses aren't able to reproduce themselves.

(×)

5. We should type the site address accurately.

(√)
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10) Choose the correct answer from the brackets:
1. After opening Internet Explorer, the website address is written in the ………………..
bar.

(Address – Menu – Website Address)

2. To load the site, click Go or press ……………….. Button from the keyboard.
(Shift – Enter – Ctrl)
3. To print a page containing important information from any site, click Print from
……………….. Menu

(Edit – File – View )

4. We can chat with any person all over the world at the same time via Internet
through ………………...

(Email – Search – Chat )

5. ……………….. From the requirement for connection to the Internet.
(Paint – Telephone line – T.V)
11) Choose the correct answer from the brackets:
1. One or group of related web pages is called ………..…….
(Site main page – Website – Web Page)
2. A link which transfers you to another site is (Site address – Email – Hyperlink)
3. After typing the site address in Internet Explorer, press ………..……. Button from
the keyboard to load the site.

(Alt – Shift– Enter)

4. ………..……. click on Internet Explorer icon to open this site window.
(One – double – three)
5. The site address is typed in ………..……. in the browser window.
(Address Bar – Title Bar – Tools Bar)
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12) Give the suitable term for the following sentences:
1. The tag which contains the title of the web page which appears in the browser's
Title Bar.

(<Title>)

2. Means all what is typed between the brackets < >.

(Tag)

3. A simple and easy language which is used for creating and designing the
information page on the Internet.

(HTML)

13) Correct the underline in the following sentences:
1. You can view the code of any information page by opening File menu and
selecting Source in the browser.

(View)

2. The difference between the start and end statements is -.

(/)

3. To save the statements in Notepad, select Open from File menu.
(Save or Save As)
4. WordPad is one of the Internet browsers.

(Internet Explorer)

5. All HTML files should ends with the statement <HTML>.

(</HTML>)

6. All the contents of the web page are typed in the code between the start and the
end of the tags <HTML>.

(<Body>)

14) Complete the following:
From the advantages of the Internet Network:
1. The ease of connection and dealing with the Internet.
2. Providing a great of information in all fields.
3. Providing recent information.
4. Connecting with any place in the world and in any time.
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15) Put (√) or (X) :1. BgColor property is being shared by many Tags.

(×)

2. To view the designed files by HTML, use the paint program. (×)
3. We can’t change style of the default font of the browser.

(×)

4. To change the font style, we use the property Face.

(√)

5. Align is used for changing the text location in the web page. (√)
16) Choose the correct answer from the brackets:
1. BgColor is used with Tag

(<P> - <Body> - <Title>).

2. To save changes, select

(Save As – Open – Save).

3. From the properties of < P> Tag is

(Align – BgColor – Background).

4. To refresh the web page and view the changes, press …….. Button on the
keyboard.

(F2 – F5 – F3 )

5. We should type the text which needs to be processed ……..End Tag.
(Before – With – After )
6. To change the font size to bigger font:
a. <Font size = (7)>
b. <Font size ="7">
c. <Font size = 7 >
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17) Put (√) or (X):1. When using the Tag <BR>, it should be ended with the Tag </BR>.

(×)

2. The property Dir is used with the Tag <Body>.

(×)

3. Center tag is used for aligning the text to the middle of the web page.

(√)

4. To create a numbering list, we use the tag <OL> and </OL>to determine the end
and start of the list.

(√)

5. The single tag <LI> is used for creating the items in the sequential list only.
(×)
18) Match from (A) to the suitable in (B):A

B

1

<Center>

A

It is a single tag which is typed at the end of the line
for creating a new line or paragraph.

2

<P>

B

A property which is used for controlling the shape
of symbols in the lists

3

<BR>

C

A tag for aligning the text at the middle of the page
in general

4

<DIR>

D

A tag which is used in alignment by using the Align
property

5

Type

E

A tag for adding an item in the list

6

<LI>

F

A property which is used to control the text
direction in the page

(1, C)

(2, D)

(3, A)

(4, F)
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(5, B)

(6, E)

19) Give the suitable term for the following sentences:
(Start button – program – loading a program)
1. Copying a program from the hard disk to memory and the program display on the
screen.

(loading a program)

2. A button on the desktop, when clicking it, a menu opens and is used for opening
programs. (Start button)
3. One or more files saved on the memory, when double click on it, a copy of it will
be on the memory and will appear on the screen. (program)
20) Match from (A) to the suitable in (B):
A

B

1

Status Bar

A

An empty white space for typing in it.

2

Title Bar

B

A set of menus containing commands.

3

Scroll bars

C

4

Text Cursor

D

5

Tool Bar

E

6

Menu Bar

F

7
(1, E)

Space of writing

G

(2, D)

(3, F)

It appears in the typing space and takes the shape
of I
It contains the program and file names.
It is down to the program window and it displays
information about the page.
It displays the hidden location in the page.
It contains icons for the important commands in
the menus.
(4, C)
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(5, G)

(6, B)

(7, A)

21) Complete the following sentences from between brackets:
(Format – Format Bar – Edit – Selection – Open - File)
1. Selection means selecting a part or all of the text to format it.
2. Format means the style of text as the text size and color.
3. To open a text file on the computer, select Open from File menu.
4. We can format the text by Format Bar.
5. To create a new Document, select "New" from File Menu.
22) Match from (A) to the suitable in (B):
(A)

(B)

1

A

To make the font italic.

2

B

To underlline the text.

3

C

To make the font bold.

(1, C)

(2, A)

(3, B)
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23) Put (√) or (×):
1. When making changes to a previously saved file, there will be no difference
between Save and Save As.

(×)

2. There is automatically an icon for Save As in the Toolbar.

(×)

3. We can't connect many printers to the computer.

(×)

4. Print and Print Preview have icons in the Toolbar.

(√)

5. We find Save and Print command in Edit menu.

(×)

24) Complete the following sentences from the brackets:
(File – paper – Print Preview – Close – Save As – Save in )
1. To select Save As, open File Menu.
2. When applying changes to a previously saved file and we want to change it name
or location, select Save As.
3. Select save location from the menu beside Save in.
4. We use Print Preview to make a preview of the page before printing it.
5. To close Print Preview window, click Close.
6. The printer is a device which is used to get the document in the form of paper.
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Model One
A. Put (√) or (×):
1) Internet network means the connection of computers in the same location.
(×)
2) Hyperlink may be in the form of an image in the web page. (√)
3) Paint program is used to deal with the texts.

(×)

4) The site may be one web page or more connected together. (√)
5) The virus is a program which has destructive and unwanted functions.
(√)
B. Complete the following sentences from the brackets:
(WordPad – Modem – HTML – Identity theft – Start)
1) HTML is a language which is used to design the internet pages and sites.
2) WordPad is used to deal with texts.
3) We can open any program on the computer by Start menu.
4) Identity theft Is of the harmful consequences from using the internet.
5) Modem Is a device which connects computers by the telephone line.
C. Arrange the following steps for opening WordPad program:
1) Select Accessories.

(3)

2) Open Start menu by clicking Start from the Task Bar.

(1)

3) Select WordPad from the menu that will appear.

(4)

4) Click on All Programs.

(2)
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Model Two
A. Correct the underline in the following sentences:
1) Color property is from the properties of <Body> in HTML. (Font)
2) E-mail is used in making conversations among many persons on the internet.
(Chat)
3) In HTML the tag < Title > is what all the page contents are typed in it.
(Body)
4) Save As is used to save changes to the document in WordPad program with
the same name.
(Save)
5) Saving HTML should be with the extension txt.
(html)
B. Complete the following sentences from the brackets:
1) ……………. Menu is used to format the text in Notepad.
(View – Format – Edit)
2) The tag ……………. Is used in typing the text in the middle of the page.
(< Center > - < Title > - < Body >)
3) ……………. Means a text or image in the web page to move to another page
or site.
(Hyperlink – Website – URL)
4) After typing the site address in the browser, click ……………. To load the
site.
( OK – Yes – Go )
5) ……………. Bar is used to view the hidden part of the paper in the Notepad.
(Menu – Scroll – Status)
C. Complete to design a web page in which the word “Egypt” appears in
the Center of the page and the Title is New :
<HTML>
<Head>
<Title>
New
</Title >
</Head >
<Body>
<Center>
Egypt
</Center>
</Body>
</ HTML >
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Model Three
A. Put (√) or (×):
1) Save is used in WordPad to save changes.
(√)
2) There is no difference between the tags <P> and < BR > when creating a new
line.
(×)
3) The tag < L > is used for adding an item to the sequential list. (×)
4) From the ways of using the internet safely, is to upgrade all the programs
including the operating system copy.
(√)
5) To activate the page in the browser, press F2 on the keyboard.
(×)
B. Complete the following:
1) From the advantages of HTML:
a)Simple Rules
b) Not related to a certain Operating System
2) The steps for printing two copies from the current page in the WordPad
program: a) Open File menu and select Print
b) Select the number of
copies(2) in the Number of Copies
c) Click on Print
C. Complete to design web page with a yellow background containing a
headline ( The Egypt universities ) in the center of the page in red color
with font size 6 and contains a sequential list of the names of four
universities:
<HTML>
<Body BgColor = "Yellow">
<P Align = "Center">
<Font Color = "Red" Size = "6">
The Egypt universities
</ Font >
</P>
<OL>
<LI>Cairo university
< LI >Ein Shams University
< LI >Alexandria University
< LI >Tanta University
</OL>
</Body>
</HTML>
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